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1. L’export de notices (biblios et autorités)
1.1 Export de notices Bibliographiques
Cette fonction est disponible dans Koha ici : Accueil › Outils › Exportez les données

1.1.1 Les critères de sélections
On peut choisir plusieurs critères de sélection pour exporter des notices :

• par tranche de numéros de notices

Cette fonction peut être sans doute intéressante si on veut traiter tout son catalogue par tranche, 
pour ne pas surcharger le système pendant l’export.

• Par type de document (valeurs paramétrées dans Accueil › Administration › Gestion des 
types de document)

• Par sites (valeurs paramétrées dans Accueil › Administration › Tous les sites), renseignés 
dans le champ « bibliothèque propriétaire » de l’exemplaire :

• Par tranche de cotes :



• Par date d’entrée dans la collection :

• En utilisant un fichier contenant des numéros de notices biblionumber de Koha

Cf. Partie 1.2 de la formation

1.1.2 Les options
• On peut choisir d’exporter ou de ne pas exporter les exemplaires :

• On peut choisir d’exporter seulement les exemplaires des sites qui ont été sélectionnés ci-
dessus. (C’est à dire que si sur une notices, il y a plusieurs exemplaires localisés dans des 
sites différents, seuls les exemplaires des sites sélectionnés seront exportés)

• On peut choisir de ne pas exporter certains champs (champs qui nous paraissent incomplets, 
faux, inutiles).

1.1.3 Les formats d’export
• Format Marc = fichier ISO2709 encodé en UTF8
• XML : un fichier XML en MarcXML (cf. https://www.loc.gov/standards/marcxml/)
• en CSV : dans ce cas, il faut avoir paramétré un format d’export dans Koha (cf. partie 1.3 de

la formation)

1.2 Création d’un fichier de biblionumber

https://www.loc.gov/standards/marcxml/


Les options d’export peuvent paraître parfois insuffisantes si on veut exporter une partie très 
spécifique de nos collections. On peut utiliser les rapports sauvegardés dans Koha pour exporter un 
fichier de biblionumbers qui pourra être utilisé par l’outil export.

Dans le module Accueil › Rapports › Assistant de rapports › Rapports sauvegardés

On peut créer ou modifier des rapports qui exportent des données du catalogue.

Vérifiez que la requête interroge bien la table biblio ou biblioitems ou items ou biblio_metadata. 
Toutes ces tables ont un champ biblionumber.

> Cliquer sur la flèche à côté de « exécuter » et choisir « voir »

Vérifier que la requête contien « FROM items » ou « FROM biblio » ou « FROM  biblioitems » ou 
« FROM  biblio_metadata »

Si c’est le cas, regarder si le SELECT contient biblionumber (ou  items.biblionumber, 
biblio.biblionumber, ….).

> Si ce n’est pas le cas, on peut l’ajouter : Cliquer sur la flèche à côté de « exécuter » et choisir 
« Modifier »

Après le SELECT, ajouter « biblio.biblionumber, » ou « biblioitems.biblionumber, » ou 
« items.biblionumber, » ou « biblio_metadata.biblionumber, » selon la table qui est interrogée par la
requête.

Enregistrer avec le bouton « Mettre à jour SQL ».

> 1.2.3. Lancer la requête :

La première colonne contient les biblionumber



Ensuite, il est possible de télécharger la liste :

Dans « Télécharger », choisir : Texte séparé par une tabulation.

Il est possible d’ouvrir le fichier téléchargé dans un tableur. Ne gardez que la première colonne et 
supprimez les autres et enregistrez le fichier au format txt. Ce fichier pourra ensuite être utilisé dans
l’outil d’export.

1.3 Les profils d’export csv
On peut paramétrer quels champs marc on veut voir exporter dans son tableur si on choisit les 
profils d’export csv.

Aller dans Accueil › Outils › Gérer les profils d'export CSV.

Avec le profil « Marc », on peut 
dire quel champ/sous-champ unimarc on veut exporter et dans quelle colonne.

Dans Champs Marc « ISBN=010$a » signifie qu’on va exporter les valeurs du sous-champ 010$a 
dans une colonne du tableur dont l’intitulé sera « ISBN ».

Chaque colonne du tableur est séparéé par un |

« ISBN=010$a|EAN=073$a|Titre=200$a » : Le fichier d’export contiendra 3 colonnes intitulées 
ISBN EAN Titre.

1.4 Export de notices Autorités
Cette fonction est disponible dans Koha ici : Accueil › Outils › Exportez les données :



Onglet « Exporter les notices d'autorité »

1.4.1 Les critères de sélection
On peut choisir plusieurs critères de sélection pour exporter des notices :

• par tranche de numéro d’autorités

Cette fonction peut être sans doute intéressante si on veut traiter tout son catalogue par tranche.

• Par type d’autorités (valeurs paramétrées dans  Accueil › Administration › Types d'autorités )

• En utilisant un fichier contenant des identifiants internes des autorités authid de Koha :

Cf. Partie 2.2 de la formation

1.4.2 Les options et formats d’export

Options :

On peut choisir de ne pas exporter certains champs (champs qui nous paraissent incomplets, faux, 
inutiles).

Formats d’export :

• Format Marc = fichier ISO2709 encodé en UTF8



• XML : un fichier XML en MarcXML (cf. https://www.loc.gov/standards/marcxml/)

1.4.3 Création d’un fichier de authid
On peut créer des fichiers de authid à partir des requêtes SQL. On procédera comme dans la partie 
1.2 mais avec des requêtes de la forme :

SELECT authid, ExtractValue(`marcxml`,'//datafield[@tag="280"]/*')

FROM `auth_header`

WHERE ExtractValue(`marcxml`,'//datafield[@tag="280"]/*') LIKE '%con%'

2. Import et modifications de notices

2.1 Import de notices
L’import de notices peut se faire à partir d’un fichier ou via une connexion SRU ou Z3950.

2.1.1 Connexion SRU ou Z3950
Dans Accueil › Administration › Serveurs Z39.50/SRU, on peut paramétrer les serveurs qu’on 
souhaite paramétrer.

Ensuite, on pourra récupérer des notices dans l’onglet Catalogage

Un clic sur la petite flèche permet de choisir dans quelle grille de catalogage sera récupérée la 
notice.

2.1.2 Import de fichiers
Dans Accueil › Outils › Téléchargement de notices dans le réservoir

On peut importer des fichiers marc

Plusieurs paramètres sont à sélectionner :

https://www.loc.gov/standards/marcxml/


Type de notices : bibliographiques ou autorités

Encodage : très important pour avec des caractères accentués corrects.

Format : MARC pour les fichiers ISO2709 ou MarcXML pour des fichiers MARCXML.

Si des modèles de transformation de notices ont été paramétrées, on peut en choisir un. Cela permet 
de changer le contenu d’un champ ou de copier un champ dans un autre champ. (cf. 2.2)

Les règles de concordance vont permettre de déterminer comment faire le dédoublonnage :

On peut choisir si on veut écraser la notice en cas de doublons ou ne pas la charger.

Ensuite, on peut choisir d’importer les données exemplaires (dans les champs 995 en unimarc) ou 
pas :



Les notices vont être importées dans un réservoir :

Dans ce réservoir, on peut voir la liste des notices prêtes à être importées et visualiser la notice marc
en cliquant sur le titre :

À ce stade, on peut de nouveau modifier ses choix pour le dédoublonnage avant de cliquer sur le 
bouton « importer dans le catalogue » :



2.2 Modèle de transformation de notices
On peut grâce à ces modèles changer des informations de la notice marc entrante.

Dans Accueil › Outils › Modèles de transformation MARC

1ère étape : création d’un modèle

2ème étape : ajouts des actions

Plusieurs actions sont possibles :

Et à chaque fois on peut ajouter des conditions. Voilà plusieurs exemples :

Si on charge des notices de documents électroniques et que l’on doit ajouter un proxy, on peut le 
faire avec « copier et remplacer » en cochant « expression régulière ». Dans la 1ère case, on ajoute 
la chaine de caractères à remplacer et dans la 2éme case, celle par laquelle on veut la remplacer :



On peut créer des exemplaires en ajoutant les champs qui correspondent :

2.3 Modification de notices par lot
L’outil de modification de notices par lot va utiliser les modèles de transformation marc décrites ci-
dessus.

 Accueil › Outils › Modification de notices par lots

 En entrée, il faut saisir une liste de numéros de biblionumbers ou charger un fichier avec cette liste.

Cf. Partie 1.2 de la formation

3. Introduction à MarcEdit
MarcEdit est un logiciel de visualisation et d'édition de fichiers ISO2709  qui peut être utilisé pour 
effectuer de petites modifications. Il permet aussi de transformer un fichier excel avec des champs / 
sous- champs marc bien formatés en un fichier unimarc.

3.1 Installation
À télécharger sur ce site : https://marcedit.reeset.net/downloads  : trouver l’exécutable 
correspondant à son système d’exploitation, l’enregistrer et l’exécuter.

https://marcedit.reeset.net/downloads%20


Comment se présente Marc Edit ?

Seuls les parties « MARC Tools », MarcEditor, Export Tab Delimited seront abordées.

3.2 Visualisation d’un fichier ISO2709
Les fichiers ISO2709 ne sont pas lisibles « à l’oeil nu » et on peut utiliser MarcEdit pour les 
visualiser et travailler dessus.

Cliquer sur Marc Tools

On garde l’opération « marc breaker » qui va « casser » le fichier iso2709 pour le rendre lisible.

On clique sur le répertoire en face du champ « open » pour aller chercher le fichier qu’on veut 
éditer.

Par défaut, les fichiers recherchés auront l’extension mrc, mais on peut cliquer sur la flèche pour 
choisir « all files ».



Save as : choisir l’emplacement où sera le fichier lisible : il sera enregistré au format « .mrk »

Il faut ensuite choisir l’encodage du fichier (à demander à ceux qui vous l’ont fourni). Par défaut, 
les fichiers issus de Koha sont en UTF8. Si besoin, on peut changer l’encodage en cliquant sur les 
cases « translate to MARC8 » ou « translate to UTF8 » mais il faut connaître l’encodage de départ 
du fichier.

On peut alors cliquer sur le bouton « execute ».

On fois le processus terminé, un bouton « edit records » apparaît, on peut cliquer dessus pour lire 
notre fichier.

Ici, on peut utiliser la fonction Edit → Find pour trouver du contenu. Cliquer sur « find all » pour 
rechercher sur toutes les pages.

3.3 Modifications dans le fichier
Lorsqu’on est en visualisation du fichier mrk, on peut aller dans l’onglet Tools :



Là, on peut ajouter / supprimer des champs (add/delete fields), modifier des champs (edit field 
data), modifier des sous-champs (edit subfield data).

Par exemple, si on récupère chez un éditeur des notices pour des ebooks mais avec de mauvaises 
données codées (assez fréquent) et qu’on veut remplacer le code nam par nlm (remplacer m comme 
monographie par l comme ressource électronique).

Voici comment se présente la notice :



Pour changer le 6ème caractère du header nommé LDR, on peut procéder ainsi :

Tools > Edit Field Data

FIELD = LDR

• Find : le caractère que l’on veut changer (ici a)

• Position : si on veut indiquer quelle est la position de ce caractère, ici il commence à la 
6ème position et se termine à la 7ème → 6:7

• Replace : le caractère qu’on veut mettre à la place : ici l

Autre exemple, imaginons que le code de langue soit faux en 101$a



Tools > Edit Field Data

Une fois qu’on a fait les modifications, on enregistre : File → Save

Ensuite il faut recompiler le fichier pour l’avoir de nouveau au format ISO2709 : File → 
Compil File into Marc.

3.4 Transformer un fichier Excel en fichier MARC
1. transformer son fichier Excel en fichier texte (avec des tabulations en séparateur comme dans 
l'exemple ou autre)

2. ouvrir marcedit : "Export Tab delimited text translator"

3. choisir le fichier texte puis le fichier marc de destination



4. cliquer sur « Options » pour choisir le format Unimarc et changer les données codées si besoin

5. faire correspondre une colonne du fichier text à un champ marc et cliquer sur « add argument » :



6. cliquer sur Finish

7. ensuite, on peut ouvrir son fichier avec Marc Editor

8. Si cela correspond, on doit compiler le fichier pour l’avoir au format ISO2709 : File → 
Compil File into Marc.

Pour compléter, voici un guide plus riche sur l’utilisation de MarcEdit, mais sur une version 
antérieure : https:/  /  koha.communaute.collecto.ca/wp-content/uploads/2015/11/Guide-  
MarcEditMontmorency.pdf

https://koha.communaute.collecto.ca/wp-content/uploads/2015/11/Guide-MarcEditMontmorency.pdf
https://koha.communaute.collecto.ca/wp-content/uploads/2015/11/Guide-MarcEditMontmorency.pdf
https://koha.communaute.collecto.ca/wp-content/uploads/2015/11/Guide-MarcEditMontmorency.pdf
https://koha.communaute.collecto.ca/wp-content/uploads/2015/11/Guide-MarcEditMontmorency.pdf
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